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General Information about the Sydney Stereo 
Camera Club and about 

3D Photography Groups in Australia 

For those living in the Sydney area and for 

those visiting Sydney, the Sydney Stereo 

Camera Club meets at 8.00pm on the third 

Tuesday of each month (except December). 

A sketch showing our meeting place is on 

the right.  The GPS coordinates are: 33º 51' 

48" S; 151º 07' 58" E.  Meetings usually 

have a guest presenter and a club 3D digital 

image competitions in either open or a set 

subject categories.  Meetings conclude at 

about 10.00pm with tea and coffee. 

 

Virtual meetings using the Zoom platform are held on the Thursday of the same week as our face-to-

face meeting. The zoom meeting allows interstate and overseas members and visitors to participate in 

meetings. 

The Club has about 70 members, including country, interstate and overseas members. Additionally 

‘3D Window’ (the Club Bulletin which is published six time a year) is exchanged with several 

overseas 3D photography groups.  

A biennial convention is held with the Melbourne based Victorian 3D Society and with the Australian 

Stereoscopic Society which attracts about 60 participants from around Australia and usually some 

international visitors. 

Many of our members belong to the International Stereoscopic Union (ISU) which publishes 

Stereoscopy, a high quality quarterly journal on stereo photography which includes technical articles 

and coloured 3D images from stereo photographers around the world.  The ISU holds an International 

Congress every two years. The ISU website is: http://www.isu3d.org/  

In addition to belonging to the ISU, some of our members also belong to one or more of the following 

associations: 

 Photographic Society of America (3D Division) who publish the PSA Journal each month; 

 National Stereoscopic Association (NSA) who publish Stereo World, a bi-monthly journal on all 

things stereo including 3D movies, old stereo cards and 3D photography; and 

 Australian Stereoscopic Society who arrange Postal 3D Slide Folio Circuits throughout 

Australia and overseas. 

The Sydney club host an international competition each year, known as the Southern Cross 

International Exhibition of Stereo Photography.  The accepted images from this exhibition are 

projected each year at our April meeting. 

Some back issues of 3D Window (our bulletin) are available in electronic format as Adobe Acrobat 

‘PDF’ files. Electronic back issues are free to members. Back issues can be downloaded from the 

‘Files’ section of the SSCC Groups.io email group – see below. 

SSCC Internet Web Site (and Southern Cross Exhibition Site): http://www.oz3d.info 

SSCClub email group (members only): https://groups.io/g/oz3d/ 

information sheet by Ray Moxom (September 2020) 
Email: raymoxom@tpg.com.au 

http://www.oz3d.info/
https://groups.io/g/oz3d/
mailto:raymoxom@tpg.com.au


SYDNEY STEREO CAMERA CLUB INFORMATION PACK FOR NEW MEMBERS ( w: www.oz3d.info)      Page 2 

THE IMPORTANCE OF THE 1 in 30 RULE IN 3D PHOTOGRAPHY 
 

There is a rule of thumb that says the distance from a 3D camera to the nearest object in the image 

being taken should not exceed 30 times the lens separation of the 3D camera. 
 

A Fujifilm W3 camera has its lenses spaced 75mm apart. From the 1 in 30 rule, there should be 

nothing in the photo that is closer than 30 times 75mm, which is 2,250mm or 2.25 meters. 
 

It is also important in 3D photography to have depth. So it is desirable to have some foreground 

elements. A good 3D photo taken with a Fuji W1 or a Fuji W3 will have the closest elements in the 

photo somewhere between 2.25 meters and 4 meters from the camera.  
 

Most 3D photos benefit from having foreground, middle ground and background elements. 
 

Also see the detailed article in this information pack on the “Two 1 in 30 Rules”. 
 

 

Fujifilm W3 
3D Camera 

 

Suggested Initial 
Settings for 
Beginners 

 
 

ISO = 100 
 

Mode = P 
 

Image Size = L4:3 
 

MPO 3D Rec = MPO 
 

Flash = Suppressed 
 

 

  

http://www.oz3d.info/
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3D Digital Camera Options 
Production of 3D Digital cameras has now stopped, however it is still possible to purchase new 

cameras online, either locally or from Japan. 

While the Fuji W3 is by far the most popular, other options for closer 3D photography are shown 

below. 
 

 
 

The Panasonic Lumix 3D1 with lens separation of 30 mm is an ideal camera for portraiture and other 

subject matter that is about 1 m to 2 m from the camera.  

A Micro 4/3 camera with a modified Panasonic Lumix 3D lens lens separation of 10 mm is for much 

closer 3D photography, such as photographing small animals and insects. 

 

   
 

Above are photos of inserting spacers between the lens mount plate and the lens to allow close focus 

when using a Panasonic Lumix 3D lens. 

Other 3D camera options are to twin a pair of digital cameras or to use a single camera and take a pair 

of photos while moving the camera between exposures. This single camera method works only for 

stationary subject such as the building shown below.  

  

http://www.oz3d.info/
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UPDATED BY RAY MOXOM 

Beginners Guide to Stereo Photo Maker 
for Fujifilm W1 and W3 Digital 3D Cameras 

by David Starkman   [This is an update of David’s article published in the January 2010 issue of 3D Window, the 
newsletter of the Sydney Stereo Camera Club] 

 
Fujifilm W1 

OR 

 
Fujifilm W3 

+ 

 
StereoPhoto Maker (SPM) is a FREE program for just about anything that you might want to 

do to a (3D) stereo image pair to make it suitable for comfortable 3-D viewing. (Google 

stereophoto maker to find it easily.) 

This program is especially useful to users of the Fujifilm Finepix Real 3D W1 and W3 digital 

cameras, as it will allow you to open the MPO image files created by the camera, and to edit, view, and 

print, them in a wide variety of ways (ways not explained by Fujifilm). Hereafter I’ll refer to the camera 

simply as the W3. 

I mentioned this program in my article "Getting Started in Digital 3-D: One User’s Report" that was 

published in the January 2008 issue of 3D Window. 

This article is not meant to be a full tutorial, but rather a basic introduction to the SPM program. 

Before you begin using SPM, the first step is to ORGANIZE your files! At a minimum you want to 

create five folders: first a folder with a subject name (such as the name of a person, place or event), 

and within that folder at least four subfolders. First, there should be a folder called MPOs (for the 

original images), and then L and R (for the extracted and adjusted side-by-side 3D pairs). Then 

Edited L & R (for images that are further adjusted for printing or other purposes), and (optional) 

3DMovies (for movie files, if you do these). These are only suggestions that I have found useful. 

Modify these suggestions to suit your own needs and workflow. NOTE: I have not recommended that 

you create a 2D JPG folder as I no not see the point in SPM users saving both MPO files and a 2D 

JPG, even though the default setting on the W3 camera is [MPO+JPG]. I recommend that you change 

the default to just [MPO] and get 50% more images on your memory card. (My partner, Susan, adds 

an “Aligned TIFF pairs” folder so she can first save the pairs as TIFFs, which she then modifies with 

PhotoShop.) JPGs lose quality when saved and copied multiple times. Don’t skip this step, as it is 

crucial in keeping yourself organized for the next steps!  

NOTE: Some of the folder names 

in the template on the right are 

different to those used in the text. 

Also, if you wish to optimize 

images for viewing on a 

Panasonic or an LG 3D TV, you 

will require an ‘MPO for 3D 

TV’ folder. 

 

http://www.oz3d.info/
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The reason for this is that, before you upload the files from your Fujifilm W3 3D camera, it is a good 

idea to have some empty folders ready to put the files into. Once you have created the folders you are 

ready to upload your digital images. A file transfer cable comes with the camera. However, I suggest 

that the easiest way to transfer the images from digital cameras is to use a card reader for your 

computer. Most laptops come with an SD card readers built-in, but, if not, an external USB card 

reader is inexpensive and worth it! 

You will notice that I have not used the software that came with the W3 camera. You don’t need it if 

you are going to upload the files with a card reader. It’s up to you if you want to try the Fujifilm 

software, but it is not necessary. 

When you insert the card in your card reader a box will open with an “Open File Folders” option. If not, 

you will have to manually use the Windows Explorer to find the “Removable Disk” drive. When you 

do, you will find a DCIM folder. Double-click on the DCIM folder . Then you will see a “101_FUJI” 

folder. Double-click in that folder, and then you will see a list of files with numbers such as DSFC0041 

and so on. The file type will be a .MPO File. This is a multi image file format. In the case of the W3 

camera, each MPO file actually has a parallel left and right JPEG stereo pair contained within it. 

However, you need the StereoPhoto Maker software to “open” the file into a useable format. If you have 

taken 3D movies, there will also be AVI files in the folder. I suggest you delete unwanted pictures in the 

camera before uploading, although it is perfectly possible to delete bad images later, if you prefer. 

The next step is to copy all of the MPO files into the MPO folder that you have created for this group 

of images already. If you have AVI files, copy them into the Fuji3DMovies folder. 

I use the COPY function, rather than MOVE, so that the files are still on the card, in case some problem 

occurs in the uploading. Once you know you have the copies where you want them, you can delete them 

from your memory card. Learn from my experience of losing data, and COPY, rather than MOVE, your 

files. 

Now that you have your MPO image file uploaded, and in their MPOs folder, you are ready to begin 

using StereoPhoto Maker (SPM). 

First, you will need to have SPM downloaded and on your PC (sorry, no MAC version is available, so 

MAC users have to run the program in Windows emulators). SPM is completely FREE, and available 

from http://stereo.jpn.org/eng/stphmkr/.  SPM is updated frequently, so just download the current 

version. 

Assuming SPM is installed, the next step is to open the program. Once you have opened the program 

you will get a mysterious black box, with the usual popdown commands at the top, and a strip of 

icons. (see below). 

 

 

 

http://www.oz3d.info/
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Next, click on the OPEN STEREO IMAGE icon 

(first from the left, a yellow folder with red on the 

inside). 

Next to the “look in” box use the popdown arrow to 

find the folder where all of the MPO files are, until 

you see the list of MPO files that you want to work 

with. It should look like this: 

You can work with a single image by clicking on it 

and opening it at this point. 

The next step is the alignment and cropping of your 

image. There are two choices for alignment: Easy 

Adjustment (individual, user controlled alignment), 

and fully automatic alignment. 

A good tutorial in all of these functions would require lots of pages and screenshots to show you how 

these functions work. The purpose of this article is to let you know what the program can do, not to be 

a step-by-step instruction manual. There is an extensive help menu if you download it at the same 

time you download the program. 

For manual adjustment of the stereo pair, click on the ADJUST popdown from the tool bar, and then 

EASY ADJUSTMENT (or just press the letter K as a shortcut). This will bring up an anaglyph 

(Red/Cyan) version of your image, with vertical and horizontal slider bars above, and below, the 

image. There are also a lot of other adjustment options to the left of the anaglyph version of your 

images. I will not explain all of the adjustments at this time, but this is something you can experiment 

with, and learn for yourself. 

 

However, the most significant feature of this FREE program is the AUTOMATIC ALIGNMENT 

function. This can be done for a single image pair, or for large groups of pairs. 

For a single pair, such as the one described above, instead of clicking on EASY ADJUSTMENT click 

on AUTO ALIGNMENT ( or ALT+A as a shortcut). Then just wait, and the image will 

AUTOMATICALLY be adjusted for vertical, horizontal, rotation, and size matching. Once this is done 

you can check it in the manual EASY ADJUST mode, and , if desired, make a horizontal adjustment 

only, to alter the window position (usually of the main subject). 

http://www.oz3d.info/
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For large groups of image pairs you can go to the File popdown and choose MULTI 

CONVERSION. You will then get the multi conversion screen which lets you browse to the name of 

the file you want to work with, then choose the input file type (side-by-side). 

Next you choose the output file type, which offers the same options as the input file type, as well as 

the image format (JPG is the default, but TIFF and PNG formats do not lose any quality when 

modified multiple times). 

Then there is an Adjust section of the box where you may check the "Auto Alignment" option as 

well as the "Auto Color Adjustment" option. There are many other options available, but not 

necessary for the beginner. Explore them when you become more familiar with the program. I have 

found that the W3 is well matched enough, that I only use the Auto Alignment option, not the Auto 

Color Adjustment. 

Last, you set the Output Folder location by clicking on the browse button in this section. If you 

choose the same destination as the source you will not have to change settings for each new group of 

images. Just be sure to move the output image to an appropriately named folder when you are 

finished. This is where you want to use the "Aligned Pairs" file folder that you have already created 

for this purpose. Be sure to choose the FILE TYPE that you want for the output files. I normally 

choose side-by-side. 

Then you can click on the CONVERT ALL FILES button and walk away. Depending on the speed 

and configuration of your PC it can take from 5 seconds to 3 minutes per pair. My dual core Pentium 

laptop takes about 18 seconds! 

Hard as it is to believe, the program automatically adjusts the images for a correct stereo window, 

corrects image rotation, size differences, and vertical difference errors! I can say from personal 

experience that it really works! Problem images may be done manually, if the Auto Alignment does 

not work. 

Once aligned, the side-by-side images can be converted to anaglyphs, or viewed using SPM in a 

variety of formats, including Interlaced for 3D monitors such as the LG or Zalman 3D monitor. You 

can also use SPM to save your 3D image pair in MPO format, so that it may be put back onto the SD 

card for viewing in the camera or V1 viewer. This is also useful for saving 3D pairs taken with other 

3D cameras, or scanned 3D pairs. 

You can also use the PRINT STEREO CARD option to format the side-by-side pair for printing on 

4” x 6” photo paper, or in the classic vintage 3.5” x 7” stereo card format, for printing on 5” x 7” 

paper. 

The program itself is amazingly small in size, at only about 3 MB. There is also a “Help” file which 

can be downloaded, and it takes up about 25 megabytes. This has extensive illustrated instructions, 

and is strongly recommended both for help and tutorial. 

I hope this will provide you with enough information to get started using StereoPhoto Maker, and 

inspire you to download it and give it a try. For further details of the program, see the SPM web page, 

and, when you download the program also download the HELP files. The HELP files contain 

extensive instructions on all of the features of the program. 

Below is the basic screen you will see if you bring a MPO file into the program for manual 

adjustment, cropping, or even exposure tweaking or matching. I generally work with the side-by-side 

view that you see below, but you may choose other viewing options.  

Note that if you hold the cursor over the icons that it will tell you what they do. Feel free to explore. There 

are many output formats, and the Print section will format various stereo card formats! Explore! You don’t 

have to save any mistakes! 

 

http://www.oz3d.info/
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Just a couple of extra 
tips to make things run 
faster and to be able to 
later identify camera 
settings and other 
important information: 

 

If you have a recent PC it 

is likely to have a multi 

core processor (dual core, 

quad core). In Multi 

Conversion (batch) mode 

SPM can speed up 

processing on a multi core 

PC by processing two 

files at a time if you 

check the multi Job Box. 

 

 

EXIF image file 

information can be 

saved by checking 

the “add thumbnail 

image to save” 

boxes in both the 

Save mode and 

under Output File 

Setting in Multi 

Conversion mode. 

 

It is recommended 

that all of the boxes 

shown on the screen 

grabs at the right are 

checked if you have 

a multi core PC and 

all except the Multi 

Job box are checked 

for single core 

processor PCs. 

 
 

http://www.oz3d.info/
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WORKSHOP NOTES BY RAY & NANCY MOXOM 

THIS IS A STEREO PHOTO MAKER (SPM) STEP BY STEP TUTORIAL DESIGNED TO 

INTRODUCE NEWCOMERS TO EDITING 3D IMAGES 

Editing to MPO Files for Viewing on a 3D TV 
INTRODUCTION: These are specific instructions on editing a 3D image in Stereo Photo Maker 

(SPM) for viewing on a 3D-TV. All 3D TVs can view MPO (NOTE # 1) files that are played from a 

Fujifilm W3 camera connected via an HDMI cable to the TV. However, not all 3D TVs can display 

MPO files in 3D via a USB Memory Stick or an SD Camera Memory Card plugged into the 3D TVs 

USB or Memory Card slot (NOTE # 2).  Two 3D TV brands that have good support for MPO files are 

Panasonic and LG. 

Detailed instructions on using SPM can be found under the program’s “Help” function. 

While this example is for editing to 16:9 ratio 1920 x 1080 pixel images, similar steps can be used to 

edit to other ratios and sizes such as the 4:3 ratio 3D projection sizes of 1024 x 768 pixel and 1400 x 

1050 pixel. While this tutorial ask you to save the images as MPO files for viewing on a 3D TV, The 

images can just as easily be saved as JPG projection files for entering in club competitions. 

Here are the steps necessary to crop and edit stereo (3D) images for comfortable viewing on a 3D TV. 

Step 1: First set up folders for downloaded images from the camera and for saving edited images. (e.g. 

downloaded MPO files from a Fuji W3 camera could be copied into a folder named “MPO” and the saved 

files folder with MPO formatted images optimised for 3D TV could be named “3D TV MPO”) 

Step 2: Copy the unedited MPO images into the “MPO” 

folder. 

Step 3: Start Stereo Photo Maker (SPM). 

SPM opens to a large black rectangular work space. 

Step 4: Open a Stereo (3D) Image: File > Open Stereo 

Image (see screen grab on right). Find the folder were the 

image you wish to edit is located in the Look In box, 

click to highlight the desired file (the name of your 

selected file will appear in the File Name box) and then 

click open. 

 

 

 

The image will open as shown above left. (for this exercise unedited photos are assumed to be stereo 

pairs) 

NOTE: Many will find it easier to align and crop 3D images in anaglyph mode, but it is important to go back to 
side by side mode before saving the file. 

 

To work in anaglyph mode, click the Colour Anaglyph square tab (speckled square on the top line – 

(see above). 

http://www.oz3d.info/
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Step 5 Rotation: (skip to Step 6 unless you need to rotate the image due to a sloping horizon etc) 

Before starting the 3D editing, check to see if any image rotation is necessary. If rotation is required 

then go to the Easy Adjustment window by clicking Adjust > Easy Adjustment (shortcut K) This 

procedure is shown in the screen grab below and is covered in more detail in the program’s Help file – 

go to the “MENU > Adjust > Easy Adjust” instructions in the help file. 

 

Step 6 Aligning: Click Adjust > Auto Alignment (shortcut Alt + A) to automatically align the image. 

Check the Alignment (also called 3D windowing) with anaglyph glasses (if in anaglyph mode) or via 

free viewing, ScreenScope or other viewing aide (if in side by side mode). Horizontal Alignment can 

be adjusted using the left and right arrows. [left arrow moves the image forward in relation to the “3D 

Window” and the right arrow moves the image back] 

 

 
 

 

Step 7 Cropping to 16:9 3D TV Format: Click the down arrow to the right of the Cropping Tool 

(location on screen grabs above and below).  

NOTE: the CROPPING 1 and CROPPING 2 screen grabs are in Side by Side mode and the CROPPING 3 screen 
grab is in Anaglyph mode. Most will find the anaglyph mode the easiest to use for cropping the image. 

http://www.oz3d.info/
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CROPPING 1 

 

Next click free cropping option (see screen grab above) and the cropping  menu will appear as shown 

on the CROPPING 2 screen grab below. 

CROPPING 2 

 

Check the Keep Aspect-ratio box and set the Aspect-ratio to 16:9 (see screen grab above), then – click 

OK. If the 16:9 Aspect Ratio does not work for the particular image – see Step 7a in the box below. 

Use the Cropping Tool to frame the image to your liking as follows:- First left click and 

hold in one corner, drag to a diagonal corner and unclick. A four arrow curser as shown on 

the right will appear on the screen. Without clicking, move the four arrow curser so that it is 

within the crop area. Next, while still in the crop area, drag the crop rectangle to the desired 

position. The crop is complete when you release the left mouse button after positioning the 

cropping frame (see CROPPING 3 screen grab on next page).  

 

If you make a mistake, use undo and try again (i.e. go back to the start of Step 7). 

Step 7a Cropping to Other Aspect Ratios: To crop to an Aspect Ratio other than 16:9 either insert the 

new Aspect ratio (say 4:3) or uncheck the “Keep Aspect Ratio box. Even when the image is being 

edited for 3D TV it is sometimes necessary to crop to another Aspect Ratio to avoid cropping out 

important parts of the image. When this Step 7a is used, you also need to use Step 10a when resizing. 

Step 8: After cropping, recheck the Horizontal Alignment and, if necessary, adjust with the left and 

right arrows as before.  

If the Horizontal Alignment is adjusted after cropping, the cropping step (at Step 7) will need to be 

repeated as the image will no longer have an exact 16:9 ratio. With the second (minimal) cropping, it is 

best to crop to the existing base line as this is usually the foreground subject matter. 
  

http://www.oz3d.info/
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CROPPING 3 

Step 9: After 

Cropping, it is 

important to go back 

to Side by Side mode 

if you have been 

working in Anaglyph 

mode. 

 

NOTE: We now have the 
cropping fixed and the 
image could be saved as 
it is for viewing on a 3D-
TV, however as the 
maximum resolution of 
a 3D TV is 1920x1080 
pixels it is best to size 
the image to that 
resolution.  

Step 10 Resizing: Click Edit > Resize (shortcut R) to get to the resize screen (see screen grabs below) 

 

 

 

 

 

Set X to 1920 in the “X” box (the Y box will then read 1080 or a number close to that). Select Keep 

Aspect Ratio and check the Resample box. Click OK to finish resizing the image. 

 

Step 10a Resizing Images that were not Cropped to 16:9 Ratio: If you used Step 7a to crop to an 

Aspect-ratio other than 16:9, then you need to select the “Keep Aspect- ratio with border” option in 

the RESIZE 2 menu shown above. Keep X set to 1920 and set Y to 1080. The final image will have 

black borders to fill in the image to a 16:9 ratio 

http://www.oz3d.info/
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Step 11 Colour Adjustment: While many will prefer to 

save in TIFF or JPG and do any colour adjustments in 

PhotoShop, simple and quick adjustments can be made 

in SPM by using the Colour Adjustment Menu. While in 

Side by Side mode, click Adjust > Color Adjustment 

(screen grab on right) to get to the menu shown in the 

screen grab above. Make sure that similar adjustments 

are made to both the left and the right image. 

 

Step 12 Saving the file: We are almost finished, all we 

need to do now is save the edited image as an MPO file.   

While the sample screen grabs show different folders, for this exercise we could call the saved MPO 

files folder “3D TV MPO”. 

NOTE: it is a good practice to check that the image is in side by side mode before saving. 

To save the file click File > Save MPO File (shortcut Alt + S), set the Quality to 99 (slider), give the 

file a name and save the file in the folder that you created (see the screen grabs below).  

  

NOTE # 1: MPO = Multi-Picture Object (An industry standard 3D image file format) 

NOTE # 2: When it comes to viewing 3D still images on a 3D TV, the TVs that have MPO file compatibility have a major 
advantage over 3D TV that do not have such compatibility. 

MPO files can be viewed on a non MPO compatible 3D TV by copying the images into the image folder of a Fuji W3 camera and 
connecting the camera to the TV with HDMI cable.  

While not directly related to making MPO files, all HDMI 1.4 and later compliant 3D TVs can display 3D JPG images formatted to 
a special squeezed format, when the image is sent to the TV via an HDMI connection. 

  

http://www.oz3d.info/
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The Two 1 in 30 Rules 
 

In a (non existent) ideal world the following guidelines would not be necessary. Our smart 3D 

cameras would know the width of the projection screen, how far the first row of chairs was 

from the screen and the eye separations of those in the front row. Also the audience would be 

sorted by their eye separation – those with the widest eye separation would sit in the back row 

and those with the narrowest eye separation would sit in the front row. The smart 3D camera 

would then automatically adjust its lens separation with full consideration of the above and the 

relative contrast and brightness of the subject matter. 

However, we all live in the real world and need some simple to use guidelines which we call 

the “1 in 30 Rules”. These “rules” are far from perfect, but in most cases they greatly help us 

produce viewable images that do not screw the eyeballs out of our audience.  

1 in 30 Rule - Shooting Version 

The traditional version of the rule of thumb known as the “1 in 30 Rule” relates to the ratio of 

the lens separation to the distance to the closest subject matter in the 3D photo. [more accurate 

calculations using the distances to near and far objects are possible, but the equations are complex 

and not practical in the field] 

This Shooting Version of the 1 in 30 rule says “the distance from a 3D camera to the nearest 

object in the image being taken should not exceed 30 times the lens separation of the 3D 

camera”. 

The Shooting Version of the 1 in 30 Rule is of help when using standard 3D cameras, such as 

the Fuji W3, and there is distant background in the photo. 

As an example: a Fujifilm W3 camera has its lenses spaced 75mm apart. From the 1 in 

30 rule, there should be nothing in the photo that is closer than 30 times 75mm, which is 

2.25 meters. 

It is also important in 3D photography to have depth. So it is desirable to have some 

foreground elements. A good 3D photo taken with a Fuji W3 will have the closest elements in 

the photo somewhere between 2.25 meters and 4 meters from the camera.  

Most scenic 3D photos benefit from having foreground, middle ground and background 

elements. 

The Shooting Version of the 1 in 30 Rule does not apply to many Close-Up 3D images or 

to images that do not have distant subject matter 

 
1 in 30 Rule - Editing Version 

As the name suggest, this 1 in 30 Rule is used when editing digital 3D images in a computer 

program such as Stereo Photo Maker (SPM) and relates to the ratio of image width to 

maximum separation of distant elements (*) in the image. 

(*) Where an image has some elements “through the window”, then the so called rule also 

applies to these elements. It is acceptable to have elements with a separation of 1/30
th

 the 

width in front of the “3D window” and elements with a separation of 1/30
th

 the width behind 

the “3D window” in the same image, as long as none of the image in front of the “3D 

window” touches the side. 
 

 

THIS IS IMPORTANT! 
The Editing Version of the 1 in 30 Rule applies to all 3D images 

http://www.oz3d.info/
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Quick Tip: When editing 3D 
images in Stereo Photo Maker, 
“Ctrl G” will bring up the Grid 
Box. Just set the “V Line” to 29 to 
produce a grid of 30 spaces. 

 
Following are two examples of the application of the Editing Version of the 1 in 30 Rule to 

images that are a long way from complying with the Shooting Version of the rule. 

 
 

The Shooting Version of the 1 in 30 Rule was well and truly broken with my surf boat photo. 

But it is still acceptable as there are no distant elements.  

As can be seen from the notations on the following anaglyph with grid lines, the image 

complies with the Editing Version of the 1 in 30 Rule. 

 

http://www.oz3d.info/
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The image of the bee over a flower is by Nancy Moxom and was taken with the modified 

Lumix 3D lenses as described in Issue 3.2013 of Stereoscopy and in the November 2013 issue 

of 3D Window. 

This is an example of an image where the distant image elements would have had very 

excessive separation if the close image elements where level with the 3D window. (Note: this 

is an issue even though the distant elements are not very far from the camera in this close up 

case as the lens separation to closest subject ratio was close to 1 in 15) By bringing the bee 

forward of the window the distant image elements have less separation which makes the 

image easier to view and reduces ghosting when projected. 

 
 

So called Rules can, of course, be broken in special circumstances and this certainly applies to 

most close-up 3D images with the Shooting Version of the 1 in 30 Rule. However, if you 

want to avoid complaints about your projected images, it is a good idea to not stray too 

far from the Editing Version of the 1 in 30 rule.  

Also keep in mind that the contrast of far objects against the background greatly increases 

ghosting. For example, visualise a scene with a white lighthouse in the distant background. 

The left and right image distance separation of the white lighthouse against a dark blue sky 

will ghost if the separation is excessive. Ghosting would not be as noticeable if the sky was 

overcast, but then the shot would not have the same impact.  

Using the distant lighthouse with excessive separation example, you will see the lighthouse 

and a ghost of the lighthouse to one side. The reason for this is twofold – polarisation 

extinction is never 100% and the eyes are trying to fuse objects with excessive separation. 

http://www.oz3d.info/
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Saving EXIF Metadata in Stereo Photo Maker (SPM) 
By Ray Moxom 

When we shoot a digital image with either a 2D or a 3D camera, as well as saveing the actual image, we also save a 

lot of imbedded information relating to the image. This saved information, often called metadata, is known as the 

EXIF (Exchangeable Image File Format) information.  

The saved EXIF information (metadata) includes camera make and model, original time & date, edited time & date, 

exposure settings, focal length of the lens, image height & width in pixels, ISO setting, exposure bias, metering 

mode, did flash fire and editing software used as well as other useful information - all saved as embedded 

information in the image file. 

The images EXIF information can be viewed in most (if not all) image viewing software via the “File” tab or by 

using a shortcus such as “Ctl Alt I” in Photoshop, “Ctl H” in Stereo Photo Maker (SPM) or right click in Windows 

Explorer and ACDSee. 

The saved EXIF information is very useful in allowing us to 

improve our photography techniques. For example, if an 

image looks a bit “washed out”, we can check the exposure 

details and adjust the exposure compensation the next time 

we have a similar subject with similar lighting. Another 

example is checking the EXIF for shutter speed if the 

problem is motion blur. 
 

As 3D photographers the vast majority of us use the amazing 

Stereo Photo Maker (SPM) to align our images. 
 

The problem is that the default settings for SPM 

removes the EXIF information from our images. 
 

The fix is simple – just check the two boxes in 

the SPM save screen shown on the right. 
 

Once the “Add thumbnail image to Save file” and the “Copy 

original exif to Save file” boxes have been checked for the 

first time, they will remain that way and saving the EXIF 

information will become the default setting from then on.  
 

If you use the “Multi Conversion” 

option in SPM to batch process a 

folder of images, then use the 

settings shown below to save the 

EXIF information. Again, you only 

have to make these setting once and 

they will become the default 

settings from then on. 

 

Now that we are all saving our EXIF information, it is a good idea to regularly check all that saved 

information to increase our knowledge and continue to sharpen our photographic skills. 
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Sydney Stereo Camera Club 
Competition Rules 

 

 

Image Size: 
All Competitions will be in 2x1920x1080 format.  
 
Narrower images can be “black-banded” to fit the required format. Images can be of 
any dimension or shape with black-bands or borders as long as the overall format is 
complied with. A copy of the club’s Specifications for Creating 2x1920x1080 Format 
Files for Club Competitions is available from the Club’s competition director and the 
Club web site. 
 

Club Competition Notes: 
 
Award winning images from earlier years cannot be entered in monthly open and set 
subject competitions. Award winners from the October Audio Visual competition will 
NOT be included in the point score competition.  However, a separate prize will be 
awarded for this competition.  
 
Distinction 4 points; Credit 2 points; and 1 point for each entry. The maximum points 
that can be scored in any one completion by a member is limited to 15. 
 
Unless specifically requested for a particular image, all images entered in club 
competitions are available for interclub competitions and folios and for uploading to 
the club’s website and social media platforms.   
 

Alteration, Computer Generation and 2D to 3D Conversions: 
Images may be altered, either electronically or otherwise, by the entrant; adjustments 
to enhance images or creatively modify images are allowed providing the underlying 
photograph is retained in a way that is obvious to the viewer.  
 

Images may not be constructed entirely with a computer, and must be the sole work 
of the entrant. 
 

Apart from the first Open competition of the year 2D to 3D converted images are NOT 
to be entered into club competitions. 

July 2023 
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Specifications for Creating 2x1920x1080 
Format Files for Sydney Club Competitions 

 

For special 2x1920x1080 pixels club competitions each stereo image should be a single 

image file consisting of the stereo pair with the left image on the left side and the right image 

on the right side. Image width (horizontal) of each individual image should be exactly 1920 

pixels wide and the height (vertical) should be 1080 pixels, resulting in a combined image file 

width (horizontal) of 3840 pixels and an image height (vertical) of 1080 pixels. Where the 

image is not to an exact 16:9 format, image centred black banding is to be used to convert the 

image to the required 2x1920x1080 format. 

 

The name of the file for each image should contain the sequence number (01-04), then the 

maker’s name and the image title in the following format: image No (01,02,03 or 04)_First 

Name Last Name_Image title.  e.g. 01_Nancy Moxom_K1 at Speed, 02_Nancy Moxom_The 

Mad Hatter, 03_Nancy Moxom_Tulip Time, 04_Nancy Moxom_Red Rose. 

 

There is no limit on the maximum file size as long as the images are in 2x1920x1080 
JPG format. 

 

Examples of an exact 2x1920x1080 (16:9) format image and an example of a narrower image 

black banded to the required 2x1920x1080 format are shown below. 

 

 
 

 
 

The commands in Stereo Photo Maker to edit to image centred black-banded mode are: EDIT 

> RESIZE > {set X = 1920, Y = 1080 and Check the “Keep Aspect ratio With Border” Box} 

> Click “OK” > then save as a stereo pair. 

 

Note: Black banding an image that is not in a 16:9 aspect ratio will result in the image being 

smaller on the Screen. 
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As long as photography has existed there have been stereo 

photographic enthusiast, however there have only been three 

Golden Ages where 3D has been embraced by the masses.  

This article is about the First Golden Age of Stereo, but first a 

bit about the 2
nd

 and 3
rd

 Golden Ages and the revival periods. 

The Second Golden Age of Stereo commenced in the 1890s 

and continued into the early 20th century. Most of the 

stereographs and Holms viewers that we see in Australia today 

came from this 2nd Golden Age. While photography became 

very popular during this period, in the stereo area the popular 

interest was in stereographs and Holmes type stereoscopes. 

The Third Golden Ages of Stereo commenced in the late 1940s 

with the release of the 35mm Stereo Realist camera and the 

availability of Kodachrome colour film. The 3rd Golden Age 

ended in the early 1960s.  

For the enthusiast there were three significant revival periods 

for 3D. The 1930s with the availability of high quality 3D 

cameras such as the Rolleidoscop, the 1980s with the release of 

the Nimslo lenticular camera and the 2010s following the 

introduction of the Fuji 3D digital camera, the popularity of 3D 

movies, such as Avatar and the release of 3D TVs. 

Stereo photography commenced in the early 1840s, at about the 

same time as photography itself. In the 1830s and prior to the 

perfection and announcement of the photographic process, the 

British scientist, Sir Charles Wheatstone developed some 

simple stereographic sketches and a rather complicated 3D 

viewer. Wheatstone named his viewer a “Stereoscope” from 

the Greek words for “solid” (stereos) and “to look at” 

(skopein). One of Wheatstone’s early sketches, as redrawn it on 

my computer is shown below. 

While enthusiast experimented and enjoyed Stereo 

Photography during the 1840s, it was not until 1851 that the 

First Golden Age of Stereo Photography commenced, and it 

commenced in royal style.  

It was at the Great Exhibition of 1851 (1851 Exposition) that 

stereo photography captivated the imagination of the six 

million visitors to London’s 19 acres of exhibits. Exhibits were 

housed in the specially constructed Crystal Palace. The 1851 

Exposition was organised by the London Society of Arts. 

While it was officially titled the “Exposition of the Industry of 

All Nations”, it was better known as the “Crystal Palace 

Exposition”. 

Queen Victoria was one of the visitors captivated by the stereo 

photographs on show at the 1851 Exposition. One of the 

exhibitors was the French Instrument Maker, Duboscq who had 

been commissioned by Sir David Brewster to manufacture his 

stereoscopes.  

It was Duboscq who first demonstrated the stereoscope and 

stereo photographs (stereographs) to the young Queen. He also 

quickly capitalised on the Queen’s interest by arranging for Sir 

David Brewster to present her with a viewer and a set of 

stereographs. 

As a result of Queen Victoria’s interest, manufacturers of 

stereoscopes and producers of stereo photographs were 

inundated with orders. More than 250,000 viewers alone were 

sold within three months. One of the most popular 

photographic subject was the Crystal Palace itself, as well as 

many of its 15,000 exhibits. 

The Czar of Russia was unable to attend the 1851 Exposition. 

Claudet, an enterprising photographer practicing in London at 

the time sent the Czar a set of stereographs of the Exposition 

together with a viewer. The Czar was also captivated by the 

stereo views and rewarded Claudet with a magnificent diamond 

ring. 

The London Stereoscopic Company was founded in 1854 by 

George Swan Nottage who was later to become the Lord 

Mayor of London. This company produced and sold 

stereoscopic pictures and stereoscopes. They later also sold 

cameras, both stereo and conventional including the “Artist” 

range of stereo and mono cameras which were manufactured 

for them in France The London Stereoscopic Company had the 

motto “ a stereoscope in every home” and sent its 

photographers around the world to capture images of exotic 

places. Within 4 years the company had a stock of over 

100,000 different stereo pictures. 

Sets of staged stereo photographs also became popular. These 

usually had a humorous theme. One typical set of this type of 

stereo card, which many of you would have seen, is titled “The 

New French Cook”. 

As can be seen from the above the early popular interest was in 

stereo views and stereoscopes. In the 1850s and 1860s 

photography, and stereo photography in particular, was very 

much for the professionals and the very keen and wealthy 

enthusiast. 

Sir David Brewster designed the first commercial stereoscopes 

(viewers). They were basically a box with 

the lenses one end and the stereograph at the 

other (sketch at left). Some, especially those 

built for royalty, were very ornate. In about 

1864 the famous American writer, poet, 

public speaker, physician, Harvard Medical School Professor 

and stereograph enthusiast, Oliver Wendell Holmes designed a 

simpler low cost skeletal 

stereoscope. The Holmes 

Stereoscope (sketch at 

right) became the most 
popular viewer world wide. 

The first Golden Age of 

Stereo began in England and France and then spread, with 

great enthusiasm, to the USA. Unfortunately as the number of 

players in the field increased the quality dropped. This, and the 

beginning of photo engraving created a loss of interest in stereo 

photography. By 1880, particularly in Europe, the first Golden 

Age of Stereo was over. 
 

References used for this, and other articles in this series, include old 

magazines, books on stereo photography that are now long out of print, British 

and American Photographic Annuals from 1891 to the 1970s, early issues of 

Stereoscopy and input from members of the Sydney Stereo Camera Club. 
 

This article first appeared in the March 1996 Sydney Stereo Camera 
Club Newsletter. Minor updates have been added 

 

Since writing this article in the 1990, there has been a 4
th

 Golden Age 
of Stereo in the 2000s with the rise and fall of 3D TVs coupled with 

the release and then discontinuation of the Fuji 3D Cameras. 

Now for a bit of 3D History - The First Golden Age of Stereo            by  Ray Moxom 
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